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Using Equity Attribution to Understand Performance
 
 
 
 
 
 
 
 

Equity attribution, also known as micro attribution, compares a portfolio’s 
performance to that of a benchmark by decomposing the excess return to explain 
the impact of various investment decisions. 

You may analyse the results by various groupings such as industry classifications, 
regional classifications, style classifications or custom classifications. 

Equity attribution reports can be created from the Investment List, Search Criteria, 
and Performance Reporting folders or directly from the Equity Attribution section 
under the Portfolio Analysis folder. 

 
 
 
 
 
 
 
 

Overview 
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To access Equity Attribution, do the following: 

1. Login to Morningstar Direct Desktop edition. 
2. Click the Portfolio Analysis folder. 
3. Expand the Equity Attribution section. 
4. Click on Single Portfolio. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To create an equity attribution analysis report, do the following: 

1. From the toolbar, click New. The New Report dialogue box opens on screen. 
2. In the Portfolio field, type Scottish Widows Ethical A; click the fund name when it 

appears to select it. 

The Benchmark field selects the Primary Prospectus Benchmark by default, which 
is FTSE AllSh TR GBP in this instance. You could use the drop-down menu to select 
another pre-set index or click the magnifying glass to select a different benchmark. 

 Note: Equity Attribution runs on holdings, therefore you must have access to both 
the portfolio and the benchmark holdings data to run this type of analysis. 
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3. Next you can decide on the report title, let’s call it Scottish Widows Ethical analysis. 
4. Under Report Settings, select the New option. 

 Note: You could also use the settings from an existing template or report. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Click OK. The Settings dialogue box opens on screen. 
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The Settings dialogue box lets you decide, amongst other things, on the timeline of 
your analysis, the portfolio breakdown as well as investment process. 

1. Set the Start Date to 3 months ago and the End Date to Last Quarter End. 
2. Set the Display Frequency to Single. 
3. Set the Calculation Frequency to Monthly. 
4. We will keep Morningstar Sector as our Grouping option. 
5. As Investment Process, let’s use the Two-Factor: Interaction in Selection Effect. 

The Two-Factor: Interaction in Selection Effect option focuses on one or multiple 
Weighting allocation decisions prior to Security Selection. The Weighting Effect is 
primary, and the Selection Effect is secondary. The Interaction Effect is incorporated in 
the Selection Effect. 

 Note: For more information on the Investment Process, refer to Appendix A: 
Investment Process 

6. Using the magnifying glass for the Cash Proxy field, select your desired risk-free proxy. 
In this instance, I selected Euribor 3 Month, but you might want to use a risk-free rate 
more relevant to your market. 

7. From the left navigation panel, click View Settings. 

In this section, you can go through each of the titles on the left hand-side and decide 
what you would like to display or hide in your report. For now, we will leave the 
settings as is. 

 Note: For more information on those settings, please refer to Appendix B: View 
Settings 

8. Click OK. The report calculates. 

Exercise 2: Report Settings 
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Once the calculation is complete, the Highlights view will automatically get activated 
and display an overall summary of the results. Depending on how you set up your View 
settings, those appropriate views on the far left will get activated for further analysis. 

 Note: The Attribution report uses the currency of the selected fund by default. You 
could always change the currency from the toolbar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If we look at the Active Return column, we notice we have a positive active return of 
1.65. 

Let’s go to the Attribution view to interpret the results at the classification and 
security levels. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Exercise 3: Attribution 
Results
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In this example, two levels are displayed. Level 1 is the Sector breakdown and Level 2 
is the Security breakdown. 

If we go to the Active Return column, we notice we have a positive active return of 
1.65%. 

Our Active Return is driven by overall positive Allocation and Selection Effects. 

 

 

 

 

 

 

 

 

 

We can now take a deep dive and identify the key contribution and the worst 
detractors at the sector and stock level. 

1. Double-click on the Active Return column to sort descending. The Consumer Cyclical 
sector is at the top. 

2. Click the arrow next to Consumer Cyclical to expand the sector. We notice Boohoo 
Group PLC is the most contributing stock, with a return of 25.32% over the last 
quarter. This stock drives the Selection Effect of this sector. 
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3. Let’s sort ascending on the Active Return column and expand the Healthcare sector. 
Abcam PLC has a negative Selection Effect due to poor performance, and the sector’s 
Active Return is driven slightly up by a positive Allocation Effect (mostly due to a 
positive performance of AstraZeneca PLC). 

 
 
 
 
 
 
 
 
 

4. We also note the positive Contribution to Return of AstraZeneca PLC: 0.25%. 
 
 



Exercise 4: Excluding Securities from the Portfolio 
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With Equity Attribution, it is possible to exclude a security from our attribution report to 
see the effects on our Active Return over the time period analysed if the fund manager 
hadn’t invested in this security. 

To exclude an underlying position, do the following: 

1. From the Toolbar, click Settings – Report Settings. The Settings dialogue box opens. 

2. Click the icon next to the Exclusions field. The Exclusions dialogue box opens. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Expand the Healthcare sector and select Abcam PLC. 
4. Click Exclude and OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Exercise 4: Excluding 
Securities from the Portfolio 
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5. Click OK again to return to the attribution report, which will automatically calculate. 

We are back on the Highlights view. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
We note that: 

× Before excluding the security: 
o The overall Active Return was 1.65%, with an Allocation Effect of 0.96% 

and a Selection Effect of 0.69%. 
o The Healthcare sector had an Active Return of -1.21%, with an Allocation 

Effect of 0.34% and a Selection Effect of -1.55%. 

× After excluding this detractor to our portfolio: 
o The overall Active Return is 2.35%, with an Allocation Effect of 0.69% 

and a Selection Effect of 1.66%. 
o The Healthcare sector has an Active Return of -0.56%, with an Allocation 

Effect of 0.08% and a Selection Effect of -0.64% 

This report takes us back to the Highlights view and this analysis proves that the fund 
manager would have done a better job by excluding this security from its portfolio. 

Click Save to save 
your template 



Exercise 5: Attribution view 
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Let’s go back to the Attribution view and look at the information below the Attribution 
Total. 

× The report displays a section for any bonds, stocks missing performance, and 
“other” securities which are not taken into account in the Equity Attribution 
report. 

× It also now includes the Excluded section, where you can see any excluded 
securities. 

 

 

 

 

 

 

 

 

 

 

× Reported Total is the actual return of the investment reported in our 
database. For a mutual fund equivalent, it is the NAV return. For an index, it is 
the actual return of the index. This differs from the Attribution Total which is 
the weighted average returns of the underlying stocks calculated using the 
beginning of the period weight assuming buy-and-hold. In other words, the 
Attribution Total is a hypothetical return. This hypothetical return is gross of 
fees and expenses and assumes buy-and-hold, i.e. no transactions. 

The hypothetical return currently assumes dividend reinvestment on ex-date 
to be consistent with how index returns are calculated, when in reality some 
portfolios may receive dividends in cash. The hypothetical return also excludes 
securities that are below the Attribution Total row. 

× Residual is the difference between the Reported Total row and the 
Attribution Total row after accounting for a fund’s Expense Ratio. The Residual 
is an industry standard term that has been around for a long time, but quite 
often people confuse it with the Interaction term which is the third factor in a 
three-factor attribution. 

 Note: For more information on those settings, please refer to Appendix B: View 
Settings 
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Equity Attribution offers a read-made PDF output report, which you can use to 
communicate the results of your analysis. 

To generate the report, do the following: 

1. From the toolbar, click Summary PDF. The Summary PDF dialogue box opens on 
screen. 

 

 

2. Select the Include Cover Page checkbox and set the Report Title to Scottish 
Widows Ethical fund and the Subtitle to Equity Attribution Analysis. 

3. Select Include Logo and use the magnifying glass to select a picture of your choice. 

 

 

 

 

 

 

 

 

 

 

 

 
 Note: Additional views from the report can be generated with the report. In this 

example we selected them all, but in the future, you can decide to keep only those 
of interest to you. 

4. Click OK to generate the report. 

We will go through some of the pages in this report. 
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Summary PDF report
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× Highlights 
This page visualises the portfolio weights and return relative to the 
benchmark, the contribution to the return, as well as the Allocation Effect, 
Selection Effect and Active Return over the chosen time period. 

The following page displays the top 5 contributors and bottom 5 detractors, 
the top and bottom 15 stocks, as well as the top 10 portfolio and benchmark 
holdings. 

× Attribution Allocation Effects 
This page provides a summary of the Attribution view. 
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× Attribution Allocation Effect 
This page visualises the out- and under-performance as well as the over- and 
under-weighting of the selected portfolio breakdown (sectors in this instance) 
against the benchmark. 
The best allocation is on sectors that out-perform and are over-weighted, or 
that are under-weighted and under-performing. 
The worst allocation is on sectors that out-perform but are under-weighted, or 
that under-perform and over-weighted. 

× Attribution Security Selection Effects 
This page visualises the same information as in the afore mentioned page, but 
with the top and bottom 15 stocks. 
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You also have the possibility to create an Equity attribution analysis report using a 
Presentation Studio Morningstar template. This report can then be saved and added to 
one of your batches for update automation. 

To create a report from an existing Morningstar template, do the following: 

1. From Morningstar Direct, click on Presentation Studio on the left navigation panel. 
Presentation Studio opens in a separate window. 

2. Click on Morningstar Templates, then expand the Factsheets section. 
3. Double click on the Equity Attribution Detail template. The Investments: Settings 

dialogue box opens. 
4. Click on the magnifying glass to access the My Fund Selection Investment List select 

Scottish Widows Ethical A (or any other equity fund of your choice) and click OK. 
5. Using the drop-down menu for the first benchmark, select the Primary Prospectus 

Benchmark option (or any other option of your choice). 
6. Change the fund’s colour to another one of your choice and click OK to generate the 

report. 
 
 
 
 
 
 
 
 
 
 
 

7. Go to the Home tab – Workbook. On the Data tab, change the currency to Euro (or 
any other preferred currency). 

8. Set the dates to 3 Months Ago from Last Quarter End. 
9. Under Return Series, switch from Monthly Return to Weekly Return. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Exercise 7: Creating an 
Equity Attribution report in 
Presentation Studio 

Make your 
selection 

Set your time period 
and currency 
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Click on the Attribution tab. From there, you can set your preferred Grouping (the 
default being Morningstar Sector), and Investment Process amongst other things. 

 Note: For more information on the Investment Process, please refer to Appendix A: 
Investment Process 

 

 

 

 

 

 

 

 

 

 

 

 
 

10. From the toolbar, click Calculate – Workbook to calculate all components. 
11. From the left navigation page, right-click on the 1st page and click New. A blank page 

is inserted below the 1st page. 
12. Drag the 1st page down, so that our blank page is becomes the 1st page of the report. 
13. Using the Divide Page Toolbar icon, select the 1st page and divide it horizontally in 2 

sections. 
14. Add the Multiple Investments Growth Chart to the top section, and the Risk – 

Single Investment table at the bottom. 
15. Using the Divide Page Toolbar icon, divide the bottom section into 2 vertical sections 

and select the bottom-right empty box. 
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16. From the Toolbar, click Text – Investment Strategy – click on the fund name – click 
on English. The fund’s investment strategy is added to the page. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
We now want to insert a Header. 

1. Click the Format tab and select Header – Insert Header. A blank space appears at 
the top of the page. 

2. Using Divide Page, divide the Header into 2 sections (vertical split). 
3. Select the left section and click on Text – Dynamic Text – Investment Name and 

click on the fund’s name. The fund’s name will automatically be added to the Header 
space. 

4. You may format the text in the font format and size of your choice. 
5. Select the right space and click on Image – Insert Image. You can then navigate on 

your computer to select an image of your choice (such as your company logo). 
6. To apply this header to the entire report, go to the Header tab – Header – Apply 

Header to Workbook. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You may now save your Workbook as a report and eventually as your own 
template, reader to be used with other funds  
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